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IBM 2218 FRAD/Manager 


The 2218 Nways™ Frame Relay Access Device (FRAD) Frame Relay Node and Conversion Node products offer excellent solutions for tying the branch office to the centralized data center.


The 2218 Nways unit provides device/Host interconnection across a frame relay or LAN network.  It channels SNA, BSC, async, and multiprotocol LAN traffic onto a single frame relay permanent virtual circuit or private line, eliminating the need to have separate WAN links for legacy and LAN traffic.


The 2218’s ability to concentrate traffic for frame relay is based on RFC 1490, the Internet Engineering Task Force (IETF) specification that defines the encapsulation of multiple protocols in frame relay frames.  The 2218 provides an adaptation layer for optimizing serial devices and transparently transports multiple protocols on a frame relay trunk.


In addition, the 2218’s traffic management scheme for prioritization of protocols and bandwidth allocation ensures the delivery of critical SNA or LAN traffic from branch offices onto frame relay backbones.


Another advantage of the 2218 Nways FRAD is that it is fully manageable by NetView® and SNMP managers, or FRAD/Manager.  The network managers can continue to view their network using VTAM®/NetView, send commands to the remote devices, run diagnostics including LPDA®2 modem and LL2 test commands, and enable NetView performance monitor commands.


To tune and manage the mission-critical traffic, two sophisticated controls can be used to prioritize LAN and SNA traffic.  Protocols can be assigned one of four priority levels, then the priority levels can be allocated an amount of bandwidth.  This ensures that time-sensitive traffic reaches its destination.


The 2218 Nways FRAD/Manager is available for running in a Microsoft Windows or UNIX environment.
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Features


General Features


FRAD/Manager’s features include:


An easy-to-use interface that enables you to customize fields, jump between monitoring, configuration, and unit status windows, and access common commands through a button bar.


The ability to manage up to 995 units, using IP/SNMP.


Unit status ribbons with colors that depict the current status of individual units on the network.  


A Unit Detail feature that displays a graphical representation of the unit, enabling you to examine it more closely.


An Alarm Notification utility that can be configured to notify you each time a specified alarm occurs.


The ability to enable or disable ports, and configure how alarms and unit / component status is displayed (color indication).


An easy solution for upgrading units with new code.


An alarm logging feature that enables you to accumulate alarms received from remote units for later review and analysis.


Individual poll logs of all connection attempts are maintained for each unit configured in the FRAD/Manager database.


An easy-to-use menu-driven NMS Session module enables you to execute NMS commands manually, or build them from menus.


Context sensitive Configuration Help describes the parameters on any screen.  Use the F1 key to activate the help facility for the current configuration screen.


Pop-up menus give you quick access to commonly used commands.


The Connect by Address module enables you to establish sessions with units that are not configured in the FRAD/Manager database.


Diagnostic dump files are easily retrieved for review and analysis.


A tool that enables you to transfer files between the FRAD/Manager workstation and units.


An Installation Scheduler that enables you to update multiple units at a time.


A locate function allows you to find a unit by name or by managed address.


An integrated patch facility enabling node patches to be easily managed.


Features new in R3


Support for R3 Frame Relay Node product features


Support for 2265 ATM devices on the Async configuration screen.


Increased number of internal MAC addresses to support


Configurable Internal MAC Address for incoming calls


IP Re-direct without RIP


Support for 2218-0xx DSU operational statistics, on 2218 model 0xx units with the appropriate hardware support.  These statistics are available via the right-click menu when the DSU port in Unit Detail is selected.


The NetView PU can now be reset via Unit Detail.  This is sometimes desirable when the NetView session is not functioning properly.  A reset will cause the NetView PU session with the unit to be cleared and re-established.  This function is available as a right-click option when the appropriate NetView PU session is selected on the Unit tab of Unit Detail.  


Retrieving  Configurations


FRAD/Manager can retrieve a configuration from a Frame Relay Node or a Conversion Node into the configuration Editor.  This is helpful when the configuration has been modified from the NMS interface, and it is desired to reconcile the FRAD/Manager configuration database with the configuration that is actually running in the node.  This feature is supported only for units that are managed via IP.


To retrieve the configuration from the unit, at least a base configuration must exist in the FRAD/Manager configuration database.  FRAD/Manager must be in contact with the unit.  Enter the Configuration Editor for the appropriate unit.  Under the File menu, select the menu item, “Retrieve Configuration.”  A status window will appear indicating the status of the operation.  If it successfully completes, the window should appear similarly to this example:


�


Select the OK button.  The Code Version may be set to None.  This indicates that the code version on the unit has not been installed on the FRAD/Manager workstation.  Also, if a patch has been installed  on the unit, but the corresponding patch does not exist on the FRAD/Manager workstation, both the Patch ID and the Code Version will be set to None.  Install the correct code version and patch version, if required.  Examine and/or validate the configuration, to insure consistency.  The configuration can be saved (which will probably leave a configuration ID mismatch) or re-installed on the unit, which will totally reconcile the configuration database with the unit.  Although there should be no impact to installing the configuration, try to schedule installations for non-critical times.


Configuring the IP Re-direct without RIP feature


The configuration parameters for this R3 Frame Relay Node feature have been added.  These parameters can be accessed via the Miscellaneous button, then the IP Redirection without RIP button. 


Logging and error reporting for bootp


The bootp server writes a detailed log of its activities to a log file.  This log file is bootp.log, in the logs sub-directory of the FRAD/Manager directory.  If one or more units is expected to receive its IP address via bootp, and fails to do so, consult this log file.  Some apparent bootp failures may be due to errors in the configuration database.  Here are some conditions related to mis-configuration which may appear in the log file:





<unit name> is not managed via IP.


<unit name> is to be managed via LAN, but the bootp request is for WAN.


<unit name> <LAN or WAN> Port Matches But Does Not Have Valid IP Address Configured


�
Installation


To install FRAD/Manager, follow the procedures that apply to your configuration, as noted in the following sections.


Upgrading FRAD/Manager


If you are upgrading your current version of FRAD/Manager, you may install the new version to a new directory, or overwrite the existing version.  The default directory is C:\FRADMAN.


Overwriting a Previous Version


Product software release code images and configuration files are stored in the RELEASE and WORK directories.  These files will not be overwritten.


Before installing the new version, delete the old FRAD/Manager program group from your Windows desktop.  A new program group will be created during the installation.


Installing FRAD/Manager


If you install FRAD/Manager to another directory, you will need to re-install the product software release code for each product type configured in the FRAD/Manager database (see the FRAD/Manager User’s Guide).


Installing FRAD/Manager from CD-ROM


If you purchased FRAD/Manager for UNIX, the Windows version is included on the installation CD.  To install FRAD/Manager for Windows from this CD, follow these instructions.  


Insert the CD-ROM into the CD-ROM drive.


Use either Explorer or My Computer to find the Windows directory on this CD.  


Double click on the INSTALL.EXE icon.


From the installation window, specify where you want the program installed, then click on Continue.


Follow the directions on the screen (see Installation Options below).


When the installation completes successfully, click on OK.


Reboot the system before starting the FRAD/Manager program.


Installing FRAD/Manager from Floppy Diskettes


Insert the FRAD/Manager Software Release diskette #1 into the floppy drive.


If you are installing from Windows 3.1, open the File menu and select Run.


If you are installing onto Windows 95, click on the Start button, then select Run.


In the Command Line text box, type A:INSTALL (or B: depending upon which drive you use), then click on OK.


From the installation window, specify where you want the program installed, then click on Continue.


Follow the directions on the screen (see Installation Options below).


When the installation completes successfully, click on OK.


Reboot the system before starting the FRAD/Manager program.


Installation Options


The following options may be selected during the installation process:


Select IP/SNMP and/or LLC-2 for the network protocol(s) you intend to use for managing units on the network.


Add LLC2 TSR to autoexec.bat


Select (() this option to add the LLC2 LAN TSR to your AUTOEXEC.BAT file.


LLCTSR.EXE is a terminate-and-stay-resident (TSR) program that must be loaded if you intend to manage units via LLC2.


If you already have the LLC2-2 TSR added to your AUTOEXEC.BAT file, deselect (() this option.  


Create FRAD/Manager Program Group


Enable this option to create a FRAD/Manager program group.


If you are upgrading your older version of FRAD/Manager and have not removed the old program group, disable (() this option.


Created Subdirectories


The FRAD/Manager installation program creates the following subdirectories under the directory you specified during the installation process:


RELEASE


Stores all product release files and software code.  Product releases are provided on separate release disks supplied with each product.


LOGS


Stores the FRAD/Manager system log files.


WORK


Stores the FRAD/Manager database.


WORK.BAK


Stores configuration backup files.


BIN


Stores the FRAD/Manager executable files.


DUMPS


Stores diagnostic dump files retrieved from the unit.


ALARMLOG


Stores alarm log files.


RETRIEVE


Used for storing configuration files retrieved from units.





Migrating Products


Products can be upgraded to higher release levels to take advantage of new features.  The Configuration Editor “Migrate” function is used to convert the configuration files from an earlier product release to a later product release.  


Additionally, the Migrate function can be used to convert the product type, in most cases. When using the Migrate function, only valid compatible product types are shown as targets for the migration.  


To update your product:


Open the configuration editor for the product you want to update.


Open the File menu and select Migrate.


�


Select the appropriate product type, then click on OK.  


The configuration editor will close automatically.


Open the configuration editor for the unit you just updated, then select a code version.  


Check all configured parameters, then open the Install menu and select Install to install the new code version onto the unit. 


De-installing FRAD/Manager


Delete all files under the application’s directory.  


For instance, if you selected the default directory during the installation, you need to delete the files and sub-directories stored under C:\FRADMAN.


Delete the application directory (for example: C:\FRADMAN).


If a FRAD/Manager program group was created, delete it from Program Manager.


To do this, select the program group, then open the File menu and select Delete.


Using a text editor, open the AUTOEXEC.BAT file and remove the TRTSR.EXE or LLCTSR.EXE line from the beginning of the file.


Close the file and save your changes.


Delete the following files from the WINDOWS directory:


CFGED.INI


CNCFGED.INI


FNCFGED.INI


FN4R2ED.INI


NMS.INI


NSTATUS.INI


QLLCFGED.INI


SNACMAN.INI


Reboot the system.


Unloading LLCTSR


Close Windows.


From the DOS prompt, change to the directory where FRAD/Manager is installed.


Example:	CD \FRADMAN\BIN	         <Enter>


Enter LLCTSR /U.





Special Notes


If you are managing units via IP, and go into Unit Detail, the unit may go out of contact for a short time.  This momentary out of contact condition does not affect the functionality of the unit in any way.  However, it takes a few moments for FRAD/Manager to update the actual status.


R3 FRAD/Manager will be the last major release that supports complete LLC management in a 16-bit Windows environment.  Current plans call for a future release of FRAD/Manager to be a 32-bit application (requiring either Windows 95 or Windows NT), using IP as the management protocol.  (LLC will be available only as a "lifesaver" capability to contact units that are currently unreachable via IP.)  Therefore, in this time frame, users should be migrating their FRAD/Manager machines to Windows 95 or Windows NT, and moving to IP management.  This will make any future migration  much simpler.  Be advised, however, that LLC support on Windows NT is not available at this time.  ��Of course, sound network planning should be employed before any major change to an operating network environment is attempted.  If you need further help or information, or if you have questions, please contact IBM Customer Support.


If you are using IP management, and have selected the “Use Agent Consolidated Status” option, and you choose not to log alarms (from the “Customize” screen), FRAD/Manager informs the nodes not to forward Traps to FRAD/Manager.  This can be helpful in situations where high volumes of alarm traffic creates network problems, but has some side effects.  If FRAD/Manager is not receiving Traps, status changes are obtained the next time FRAD/Manager polls the node for status.  Because of the poll cycle, there may be some delay in the time it takes status changes to be reflected on FRAD/Manager.  Also, the currently active configuration ID and dump file name on the Network Status ribbon bar are not updated to reflect current information.  For example, if a node is re-configured, the state will be “Informational” (Purple color) because of a perceived configuration mis-match.  The current state of the Active Configuration ID and the name of the Dump file can be re-synchronized by Updating Status.  If this is objectionable, then FRAD/Manager should be customized to Log Alarms or Agent Consolidated Status should not be used.


If using Agent Consolidated Status, and you choose to “ignore status” on a particular network element, the SNMP Agent in the node will be set in “ignore status” so that all FRAD/Managers that have monitor privileges for this unit will effectively be in “ignore status” mode.  


FRAD/Manager assisted Patch Facility


FRAD/Manager supports an integrated patch management facility for nodes that are at IBM software release R2 and higher.  The Patch facility treats the patch as an extension of the software version number.  All patch files contain a checksum that is validated when the software/patch/configuration is installed on the node.


Patches are loaded onto the FRAD/Manager machine just like node software is installed-from floppy diskette.  Once installed on the FRAD/Manager machine, the patch level can be configured from the Configuration Editor, Unit Level screen.  If the Patch button is disabled (ghosted), there is no valid patch installed for that product/release combination on the FRAD/Manager machine.  


To configure the patch version number, click on the patch button to bring up the Select Patch screen.  The Select Patch screen allows the patch version to be selected on the left side, and the description of that patch file is displayed on the right side.  Click OK or Cancel as appropriate to exit the Select Patch screen and return to the Unit Level screen.  Use the normal installation process to install or de-install the patch, as appropriate.  The node will be re-booted whenever the patch version is changed and installed.


Known Anomalies


The following problems are known to exist in this version of software.  These problems will be addressed in future maintenance releases.


SCR#  1742


Inconsistent status sometimes displayed with agent consolidated status


Description:  The status displayed by the FRAD/Manager Unit Detail screen and main ribbon bar are sometimes different.  


Workaround:  Check the Unit Detail screen or NMS to determine unit status.


SCR 2394-SAPs configured incorrectly-TSDLC to Host, no head end unit


Description:  When configuring a TSDLC PU for Originate mode, and assign a destination, the configured SAP on the PU screen is configured as a Source SAP.  This is correct.  However, when configuring the TSDLC PU for Answer mode, the SAPs are reversed, so that the configured SAP becomes the Remote SAP.  This works OK as long as the "other" box is a 2218 box-one side is configured as originate, the other side as answer, one SAP is configured on each, and they get flipped for Answer mode.  Unfortunately, this does not work when connecting directly to an IBM or Tandem host without going through a head-end 2218 box.  The host always has a Source SAP (our Remote SAP) that is the same.  It is usually 04.


Work around: Using the Destination Editor, make a separate destination for each  SAP required.  Configure the DSAP value in the Configuration Editor.  Configure the remote box, ANSWER mode PUs, to connect to this destination.  The SAPs will end up being correct.


SCR 2501-Configuration allows ISDN speed of 56k which is not legal


Description:  When configuring the ISDN port speed, the default speed is 64k.  The combo box allows 56k to be selected, which is not a valid speed.


Workaround:  Leave the ISDN speed set at the default value of 64k.


SCR 2516-Spaces illegal but not documented as such for LL2 test command data


Description:  When using the right-mouse popup menu in NMS Sessions to access the LL2 test command, spaces and the equal sign are not legal characters for the test data.  This is not documented as such.


Workaround:  Do not use spaces or the equal sign in this command.


SCR 2517-Unit goes out of contact when displaying Token Ring statistics from Unit Detail


Description:  When using Unit Detail to examine the token ring statistics of a Frame Relay Node or Conversion Node, the unit may go out of contact (short) for a few seconds.  


Workaround: This is not a service affecting problem.  The unit will come back into contact after about 10 seconds.


SCR 2518-Protocol Trace using the NAUNAME option does not work properly


Description:  If FRAD/Manager is using the NAUNAME option (set via Options/Customize/Misc menu), and you are using the right-mouse click popup menus in NMS Sessions, the Protocol trace command generated (using a NAUNAME) will not work properly on Release 3 Frame Relay Node and Conversion Node software releases.


Workaround:  Set the Options/Customize/Misc to not use NAUNAMEs.


Problems resolved in Release 3


The following problems have been fixed in R3.  Problems are sorted by fixed version and build.


SCR No�
Title�
Fixed in Release�
Fixed in Version�
Fixed In Build�
�
1429�
Invalid netmask 255.255.255.255 was not deteceted by the Config Editor�
R3�
001�
001�
�
2083�
Configuration editor destination list doesn't show all foreign destinations�
R3�
001�
001�
�
2084�
Can't configure RIP overrides on Dial BU port�
R3�
001�
001�
�
2098�
Destination menu doesn't show the complete list of destination names�
R3�
001�
001�
�
2099�
PRJE & SRJE Dial Backup Enabled by Default�
R3�
001�
001�
�
2113�
Incorrect Bridge Number Accepted by FRAD/Manager�
R3�
001�
001�
�
2135�
Correct link needs to be made for IP Redirection screen under Misc.�
R3�
001�
001�
�
2096�
FRAD/Manager fails to respond to  BOOTP client frame�
R3�
001�
003�
�
2128�
CFGIOL GPF because of bad destination name�
R3�
001�
003�
�
2138�
Bogus validation errors on AutoLLC, X.25 PUs, WAN line presence in R3�
R3�
001�
005�
�
2141�
NetView PU Restart does not work from FRAD/Manager�
R3�
001�
005�
�
1876�
FRAD/Manager Nstatus General Protection Fault Errors�
R3�
001�
006�
�
2140�
Alarm Viewer problems with European date format�
R3�
001�
006�
�
2148�
Alarm Log Viewer allows bad Day of Week input�
R3�
001�
006�
�
2152�
Can't install configuration on CS SNAC�
R3�
001�
006�
�
2189�
FRAD/Manager help for LLC receive/transmit window size is 17 s/b 15�
R3�
001�
006�
�
2121�
Status Legend needs to be changed under the Help menu�
R3�
002�
001�
�
2164�
Rx Forwarding Count is not Checked for Minimum Value�
R3�
002�
001�
�
2168�
XID value not set in FCU record�
R3�
002�
001�
�
2169�
ORT,RTC (Async) and IBS (Bisync) not generated for conversion nodes�
R3�
002�
001�
�
2186�
FRAD/Manager reports Install Successful - NMS reports CU mapping error #315�
R3�
002�
001�
�
2191�
Configuration of R1 Conversion Nodes broken-PUs get dropped�
R3�
002�
001�
�
2195�
FRAD/Manager reports install successful and NMS reports cu mapping errors�
R3�
002�
001�
�
2196�
FRAD/Manager may generate DMA = 0 or IP addr for R1 conversion node PU�
R3�
002�
001�
�
2198�
FRAD/Manager configuration screen unit level causes a Cfged error�
R3�
002�
001�
�
2207�
Add LMI = None to FRAD/Manager.�
R3�
002�
002�
�
2216�
DSU/CSU Statistics Not Available From FRAD/Manager�
R3�
002�
002�
�
2217�
FRAD/Manager BootP server fails on long BootP messages from foreign device�
R3�
002�
002�
�
1878�
Session Tuning Misspelled Maximum�
R3�
003�
001�
�
2218�
White (Ignore status) not explained in help file�
R3�
003�
001�
�
2235�
Improper validation-Token Ring LAA and Internal Address LAA�
R3�
003�
001�
�
2248�
FRAD/Manager manual file transfer - windows gpf if dump file exists in e:�
R3�
003�
001�
�
2254�
Validation problem-static route to SLIP port�
R3�
003�
001�
�
2262�
FRAD/Manager Configuration Editor will not Start�
R3�
003�
001�
�
2271�
Configuration retrieval sets LMP to AnnexA for R4 Frame Relay Nodes; should be AnnexD�
R3�
003�
001�
�
2235�
Improper validation-Token Ring LAA and Internal Address LAA�
R3�
003�
002�
�
2254�
Validation problem-static route to SLIP port�
R3�
003�
002�
�
2300�
Bogus validation after retrieval:LAN or SDLC PU: IM20 is used more than once f�
R3�
003�
002�
�
2312�
Bad validation for retrieved conversion node configuration, IP redirection parameters�
R3�
003�
003�
�
1188�
FRAD/Manager Incorrectly Displays Units Status�
R3�
500�
004�
�
2409�
Config Editor error on trying to configure a Bisync PU for dial backup�
R3�
500�
006�
�
2421�
FRAD/Manager Builds Invalid Configuration if No Internal Ring DLCI is Specified�
R3�
500�
006�
�
2425�
Config retrieve gets no MIB data, if patch facility isn't supported.�
R3�
500�
006�
�
2435�
Retrieved configuration had parameter errors when re-installed�
R3�
500�
006�
�
2447�
FRAD/Manager does not Validate Reply Timeout for Bisync RJE Port�
R3�
500�
007�
�
2448�
FRAD/Manager does not Validate Retry Count (N2) for Bisync RJE Port�
R3�
500�
007�
�
2462�
Informational Status (Purple Ribbon) in FRAD/Manager with Patch Installed�
R3�
500�
007�
�
2511�
Right Mouse popup protocol trace options FULL and ASCII don’t work properly�
R3�
502�
001�
�
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